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Videos 

We hope you are enjoying our weekly vide-
os. If you have a specific topic you would 
like to see us cover please let us know.  
If you would like us to add someone onto 
the list we will certainly take care of that.  
We feel the more education we can get out 
to you, the better.  

Cathy’s Message 

Happy Halloween everyone! I hope you 
enjoy our newsletter. We have put a lot of 
information in here and would love to hear 
from you what you like and did not like.  

Would you like to have your pet featured in 
our monthly newsletter?  Send us a picture 
and an article. We are going to start a Pet 
of the month column. So many of our cli-
ents have amazing pets and we want to 
share with all of you all about them.  

We are very pleased to announce we are 
now authorized to sell Avaya products, 
please take a moment to read about Avaya 
in our newsletter.  

Our annual Christmas party will be Decem-
ber 6th at the Bayhawks game. Please let 
us know asap if you plan on attending so 
we can get you the tickets.  We have 100 
tickets this year, and expect a full house. 

We hope you can make the party! 

 Take care and have the best month ever! 

Cathy & David 

Happy Cookie Month! 

 

 

 

 

 

 The most popular type of home-
baked cookie is the Chocolate Chip 
cookie. 

 Over-mixing the dough or adding too 
much flour can result in hard, tough 
cookies. 

 The first animal crackers were pro-
duced in the United States by Stauf-
fer’s Biscuit Company in 1871. 
Nabisco’s Barnum’s circus version hit 
the market in 1902.  

 The modern version of the Fig New-
ton was created in 1891 and is 
named for the city of Newton, Massa-
chusetts.  

 The Oreo cookie was invented in 
1912.  

 Ladyfingers are used in tiramisu be-
cause the cookies so readily absorb 
the sweet syrup and liqueur used to 
make the traditional Italian dessert. 

 While Italians use the word “biscotti” 
to refer to all types of cookies, Ameri-
cans think of “biscotti” as the long, dry 
cookies that are served with hot 
drinks for dunking. The name is de-
rived from “bis,” meaning twice, and 
“cotto,” meaning cooked. Baking the 
cookies twice results in their hard, 
crumbly   texture. 

Five Tips For  

Disaster Communication 
 
As we all know, disasters strike at any 
time. We all often go to great lengths to 
ensure that their business is protected and 
prepared for any disaster by implementing 
contingency plans. During a disaster how-
ever, the biggest issue businesses face is 
communication. If this breaks down, even 
the best laid plans will go to waste. 

Here are five tips on how to ensure better 
communication during a disaster. 

1. Have more than one way to com-
municate 
During a disaster, you have to assume that 
communications will be affected in some 
way. Therefore, you should take steps to 
ensure that your company has more than 
one way to communicate with employees 
and people outside of your organization. 

This could include mobile phones that are 
used only for disasters, extra phone lines, 
VoIP, etc. The key here is to identify how 
potential disasters could affect communi-
cations and look for alternative methods or 
ways to communicate. 

2. Coordinate responders 
During some disasters, it’s not the commu-
nications themselves that cause further 
problems, but uncoordinated responders. 
In times of disaster, people react based on 
what they think will work best in the mo-
ment. 

If you have not taken steps to ensure that 
all responders are on the same page, and 
know what they should be doing to not 
only carry out the recovery plan but also 
communicate, you could face a total 
breakdown. 

When developing your strategy, take the 
time to ensure that the selected respond-
ers and communications leaders are up-to-
date and are aware of what is expected of 
them and how they should go about com-
municating during a disaster. Cross-
training employees so they can carry out 
other roles if necessary, can be a good 
back up too.   

continued on page 2...  

XP End Of Life 

I am sure by now you have heard that on 
April 8th, 2014 Microsoft will end support for 
Windows XP and Office 2003 products.  

This means, there will be no new security 
updates, non-security hotfixes, free or paid 
assisted support options or online technical 
content updates from Microsoft.  

Windows XP is the target of many cyber 
attacks, due in large part to its age and con-
tinued widespread use. With a long list of 
documented vulnerabilities and rootkits al-
ready available to hackers, the end of  ex-
tended support will open up even more ex-
ploit opportunities. Upgrading offers an im-
mediate boost in security. If this is not 
enough to have you upgrade, here are six 
more security reasons to upgrade: Support-
ed by Microsoft, Lower infection rates, Im-
proved User Account Control, Windows 
Firewall with Advanced Security, Data Exe-
cution Prevention and More Granular Secu-
rity Auditing.  

For more information please email  
Cathy at cathy@szy.com or call 
814-455-6069 x300  

mailto:cathy@szy.com
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Video Conferencing 

We are excited to announce we are now Avaya resellers. Avaya 
is a One Touch Video Solution. A video and collaboration solu-
tion for all users. With technology creating greater opportunities 
for collaboration, the possibilities to improve meeting efficiency, 
enable on-demand face-to-face meetings and offer remote cus-
tomer service are changing at a rapid pace.  
 
The world of Unified Communications (UC) gets more complex, 
we will help you make sense of it all-leveraging familiar technolo-
gy in new ways to simplify the process of bringing people togeth-
er and helping them work more effectively.  
 
Avaya also offers phone solutions. Avaya Telephone systems 
are feature-rich, high audio quality business phones. We offer a 
range of models that suit every level of businesses.  
 
Avaya VoIP phones offer the latest technology in IP telephony 
solutions. The communication data is being traveled over the 
internet instead of using conventional phone lines, making it 
more reliable and less expensive. Whether you have small or 
large business, Avaya VoIP phone systems allow you to do 
complex task. Aside from using the internet technology, VoIP 
phones from Avaya offer advanced features that make voice/
data communication easy and fast. 
 
For more information regarding our AVAYA systems, please 
contact us. We will be very pleased to work with you on your 
needs. 

Shiny New Gadget 

The Tile 

Now it’s super easy to keep track of stuff on the go. Just attach, 
stick or drop your Tile into any item you might lose: laptops, wal-
lets, keys, guitars, bikes—you name it. Download and sync the 
app and you’ll never have to worry about losing it again! Pre-
order this little device and you’ll be able to: 

Use Tile on as many things as you 
want. Add up to 10 Tiles on an ac-
count. 

Share access to Tiles with friends, 
family, and trusted coworkers. 

Hear the alert notification when your 
items are triggered to find. If you can hear it, you can find it. 

Use the Tile app to remember where it last saw your Tile, so you 
can easily find it right where you left it. 

Pre-order your device today at http://www.thetileapp.com  

Cathy’s useless trivia: 

 Pumpkins are fruits, not vegetables.  

 Pennsylvania was the first colony to legalize witchcraft.  

 Americans consume about 20 million pounds of candy corn each 

year. 

 The first jack-o-lanterns were made of turnips. 

 It’s illegal to sell a haunted house in New York without informing 

the buyer.  

 A cup of candy corn has fewer calories than a cup of raisins.  

 Halloween is the second highest grossing commercial holiday 

after Christmas.  

Five Tips For Disaster Communication 
Continued from page 1… 

3. Coordinate responses 
During a disaster, you will have to communicate with parties 
outside of your business. This may be the media, shareholders 
or other businesses. If you have a disgruntled employee, or one 
who is not aware of the full situation when answering questions, 
the impact of the disaster could be exacerbated. 

It is beneficial to develop standard responses and methods of 
responding during a disaster. As a small to medium business 
owner it is tempting to take on this role yourself. However, while 
you should definitely be a key person to respond to questions 
from parties outside of your business, having other people in 
place who can cover this role might help mitigate disaster. 

4. Communicate outward 
In times of disaster it can be easy to forget that other people 
and businesses rely on you. If they are not fully aware of what is 
going on, there is a chance of compounding problems and even 
losing business. 

When disaster strikes, your company should take steps to com-
municate with parties outside of your organization as to what is 
going on, what you are doing to fix the problem and if there is 
any help/changes you need. After all, the more people who are 
informed of the situation, the greater the chance that support 
will be available and more effective. 

5. Be honest 
There is a temptation to put spin on a disaster within your or-
ganization and embellish the truth, or play it down so as to not 
make your business appear in a bad light. This could cause 
further problems though if important people find out that you 
have not been totally upfront and transparent. 

All it would take is one employee mentioning a hidden fact to a 
friend and the truth could come out and potentially damage your 
brand reputation and possibly lose you business. Therefore, 
when communicating with outside parties and with your employ-
ees, be honest and open as to what is really going on. This will 
make communication easier, and could even help lessen the 
long-term impact of the disaster. 

If you are looking for communications systems or disaster re-
covery plans that will help see you through any disaster, please 
contact us today to see how our solutions can support you. 

HIPAA Training 

At Szymanski Consulting, we understand that medical profes-
sionals face very real challenges when it comes to IT. The com-
plexities of Electronic Medical Records combined with the regu-
latory issues of remaining HIPAA compliant can be daunting. 
That’s were we come in. Guided by the mission to ensure your 
practice remains secure and compliant, we provide training tools 
and educational opportunities at a discounted rate.  

If you are interested in our online training, contact Cathy and 
she will be happy to direct you to the resources for the training.  
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Taking Referrals 

Do you have anyone you would like 
to refer to us! We have a referral 
program that we would love to 
share with you. Please email Cathy 

today to find out more information.  

How To Prevent ATM Skimming 

Over a billion dollars are lost each year in the United States 
through “ATM Skimming” – far more than any losses from bank 
robberies – and it’s growing at a rate of more than 10% every 
year. 

ATM Skimming is a cybercrime where the criminals steal (or 
“skim”) your ATM/debit card data when you’re using a typical 
ATM machine. They do this by fitting a small card reader over 
the typical ATM card slot, thus capturing your information. Addi-
tionally, the criminals install mini cameras above or near the 
ATM to capture your PIN number. The data is then transmitted 
via Bluetooth to the cybercriminals somewhere nearby. The av-
erage skimming attack usually lasts only an hour or two during 
peak ATM usage times (i.e. lunch hour or after work). Mean-
while, you have no idea that you’ve just been had and are at 
risk. These cyber-criminals will then sell the data on the cards to 
others so that they can either clone your debit card or wipe out 
your bank account. 

5 Tips To Prevent ATM Skimming 

Cover your hand as you type. Obstructing the view of your pin 
from any cameras will render your data useless. 

Pay attention to the area around the ATM card slot. If any-
thing looks loose or out of place, pull to see if you can remove it. 

Be aware of surroundings. Be extra careful of ATMs in dark or 
isolated places. 

Does the machine look different? If anything looks out of 
place (extra signage, mirrors, etc.) then avoid the machine. 

Notify the bank. If you find or suspect an ATM has been com-
promised, notify your bank and law enforcement immediately.  

Microsoft Word Tips 

Microsoft Word has many options to help format and edit docu-
ments.  With so many options available, here are a few tips 
and tricks to help make it easier: 
 

Ever want to compare documents? – in Word 2003 and 
older, open the documents you want to compare, and 
click on the “View” Tab.  Under the “Window” menu, 
select “View Side by Side” and select the “Arrange 
All” option. 

In Word 2007 and 2010, open the documents that you 
want to compare and move to the View tab of the rib-
bon. Click the 'View Side by Side' button, and then 
click 'Arrange All'. Press 'Synchronous Scrolling' and 
you can scroll then through both of your documents at 
the same time.  

Need to comment or proofread a document? – There’s 
no need to send a separate document, or make the 
changes and leave the original writer left to wonder.  
You can simply ad a comment by highlighting the text, 
and under the “Review” tab select “New Comment.”  
Here you can note any ideas or changes. 

Editing a document and lose your place? – If you don’t 
want to leave the comment on someone else’s work, 
or doing your own editing, never lose your place.  
When you open your document, using Shift+F5 will 
quickly take you to the last point you were working at. 
 

Tired of repeatedly hitting the Backspace/Delete but-
ton?  - If you are, then this tip is for you.  To quickly 
delete an entire word or sentence, press 
Ctrl+Backspace.  This will quickly delete the entire 
word, and save you from repeatedly hitting backspace.  
*If you need to delete something that is after your cur-
sor, pressing Ctrl+Delete will quickly delete what you 
need [Example: The quick brown fox jumped over the 
lazy dog.  If your cursor is between brown and fox, and 
you want to change fox to wolf, Ctrl+Delete will quickly 
delete that word]. 
 

Editing a document in more than one sitting? - If you 
find yourself working on the same document in multi-
ple editing sessions, you can use this tip to get started 
faster. If you open a document you were editing when 
you last used Word, you can use the SHIFT+F5 key-
board combination to quickly jump to where you were 
last working in the document. This is also a good way 
to get back to what you were editing after browsing 
through a document. 
 

Don’t worry about highlighting your words anymore (A 
quicker way to Bold, Italicize, and Underline)- Don’t 
worry about highlighting the entire word.  Just place 
your cursor anywhere in the word and press Ctrl+B, 
Ctrl+I, or Ctrl+U to get the effect you want.   
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